Paul M. Smith

Email: paul.smith@woodbury.com | On-line Portfolio: PMSdigital.com | Telephone: (818) 399-4715
Address: 13884 Shablow Avenue, Sylmar, CA, 91342

PERSONAL STATEMENT

A collaborative, knowledgeable, and highly experienced game arts professor. Provide a positive learning
experience by promoting independence, creativity and open mindedness with my students. Adept at training,
motivating others, established lasting relationships within the school community. With over 25 years’ experience
as a game developer and 3D artist, my goal is to bring my artistic, technical, and managerial skills of video game
production into the classroom.

Teaching Philosophy: | can honestly say my philosophy on teaching is this: “Every student is capable of learning,
but it is up to the teacher to find that connection with each student that will help him or her to learn best.”

EDUCATION
B.F.A and M.A: Computer Animation, William Patterson University, Patterson, NJ - 1993 — 1996

A.S: Computer Animation, Bucks County Community College, Bucks County, PA - 1991 — 1992

EMPLOYMENT HISTORY
08/2022 — present: Interim Chair in Game Art & Design at Woodbury University, Burbank, CA

e Provide students with 3D Game Art tutoring services that focus on software-based programs, related
weekly assignment questions and concerns, live and post 3D production-ready pipelines for both game
and animation, senior volunteer mentorships, and self-improvement fraining.

e Collaborate with adjunct faculty in developing or updating course material for existing game art and
design courses.

e Training adjunct faculty on university logistics and procedures, scheduled weekly course mentoring
secessions.

e Academic advising

o 8/29/22-12/15/22 (92 students)
e Discover Woodbury (2022)
o Assisted by two senior thesis students fo field Q&A
e University Service
o Adjunct Faculty Committee
> 9/08/22 -11/22/22
» The topic of AB-736 employee classification of adjunct faculty and the university's
response and procedures is of utmost importance to the committee since the
academic institution’s reputation and longevity and retaining current adjunct faculty.
Continue to review and discuss to improve the university and adjunct communication
forum, course workload and compensation, establishing an on-line faculty hiring pool,
developing an adjunct faculty ranking process, and awareness of grant opportunities.
o Create Change Committee
> 05/13/22-10/31/22
» Assisted the Create Change Committee to review submission materials for the student
competition along with the faculty grant call for applications. We discussed the intent of
the initiative to develop an increase of “awareness and design solutions to eliminate
racism and injustice” and conferred on the appropriate applicant’s financial award,
reimbursement, and guidelines.
o VR in the Classroom
> 09/29/22-11/30/22


http://www.pmsdigital.com/

» Select group of faculty members from Animation, Game Art & Design, CSMA, school of
business, staff and IT meet and decided to form an interdisciplinary VR (Virtual Reality)
commiftee. We discussed the intent of the inifiative to gather content, physical and
instructional resources, and develop commonalities in pedagogy and course goals to
infegrate aspects of Virtual Reality in the coursework amongst our programs.

e Studio Courses — 3 Units (Semester System — 15 weeks)
o GAME 303 - Advanced 3D Sculpting

> Fall 2022

o GAME 307 - 3D Character Rigging
> Fall 2022

o GAME 309 - 3D Game Animation
> Fall 2022

o GAME 431 - Degree Project: R&D
> Fall 2022

08/2019 — 08/2022: Assistant Professor Ill in Game Art & Design at Woodbury University, Burbank, CA

e Provide students with 3D Game Art tutoring services that focus on software-based programs, related
weekly assignment questions and concerns, live and post 3D production-ready pipelines for both game
and animation, senior volunteer mentorships, and self-improvement training.

Support program chair in developing or updating course material for new and existing game art courses.
Training adjunct faculty on university logistics and procedures, scheduled weekly course mentoring
secessions.

e Collaborate with the department chair and interim full-time faculty on program review evaluations and
game design curriculum change proposal.

e Support program chair in academic advising

o 1/17/22 —4/29/22 (42 students)

o 8/23/21-12/10/21 (33 students)

o 1/11/21-5/08/21 (38 students)

o 11/02/20-12/11/20 (41 students)

o 10/29/19-11/20/19 (42 students)

e Discover Woodbury (2018, 2019, 2020, 2021)
o Assist program chair and field Q&A
e MCD Creative Workshops
o 3D Modelling for Games — 2021
» Using 3D digital hard surface and organic sculpting techniques in zBrush or Zbrush Core

Mini, high school students are provided a 2D reference concept as a background
image; apply digital clay to sculpt out shape and form; and add attention to functional
and structural details. Using 3D digital painting techniques in Quixel Mixer, to apply PBR
(physical based rendering) materials and add specific painting detail layers to enhance
the story-telling aspect.

o 3D Character Design — 2018, 2019

» Using 3D digital character sculpting techniques in zBrush, high school students are

provided a 2D character concept as a background image and they create a 3D
skeleton; apply digital clay to sculpt ouf shape and form; add attention to details using
microtextures and custom brushes.

e University Service

o Adjunct Faculty Committee

> 8/30/21 -5/08/22

» The topic of AB-736 employee classification of adjunct faculty and the university's
response and procedures is of utmost importance to the committee since the
academic institution’s reputation and longevity and retaining current adjunct faculty.
Continue to review and discuss to improve the university and adjunct communication
forum, course workload and compensation, establishing an on-line faculty hiring pool,
developing an adjunct faculty ranking process, awareness of grant opportunities, and
student and faculty concerns related to COVID-19.

> 9/08/20-4/27/21



Reviewed and discussed how to provide additional support to adjuncts, improve the
university and adjunct communication forum, course workload and compensation,
establishing an on-line faculty hiring pool, developing an adjunct faculty ranking
process, awareness of grant opportunities, on-line teaching tips, and student concerns
related to COVID-19.

o Academic Appeals Committee

>
>

09/01/21 -5/08/21
As a member of the Academic Appeals Committee, | helped quickly evaluate and
expedite appeals that the registrar’s office collated and summarized into presentations.

o Create Change Committee

>
>

06/22/21

Assisted the Create Change Committee to review submission materials for the student
competition along with the faculty grant call for applications. We discussed the intent of
the initiative to develop an increase of “awareness and design solutions to eliminate
racism and injustice” and conferred on the appropriate applicant’s financial award,
reimbursement, and guidelines.

o New Faculty Learning Committee

>
>

9/12/19-12/05/19

Reviewed and discussed the institution procedures, faculty and program assessments,
uphold and improve learning outcomes, committee responsibilities, the contract
renewal, and rank advancement process.

Studio Courses — 3 Units (Semester System — 15 weeks)
o GAME 105 -3D Art Fundamentals

>  Spring 2021
o  GAME 140 - Environmental Design and Modeling
>  Fall 2021
o  GAME 237 — Materials, Lighting, Rendering
» Spring 2022
> Fall 2019

o GAME 238 — Character Design and Modeling

>

Spring (2020, 2021, 2022)

o GAME 303 - Advanced 3D Sculpting

>
>
>

Fall 2022
Spring 2022
Spring 2021 - Directed Study

o  GAME 307 - 3D Character Rigging

>

Fall (2019, 2020 2021, 2022)

o GAME 308 - Cinematic Animation

>
>

Spring (2020, 2022)
Spring 2021 — Directed Study

o GAME 309 — 3D Game Animation

>
>

Fall (2019, 2020, 2022)
Fall 2021 - Directed Study

o  Senior Workshop

>

Fall2019

o GAME 431 - Degree Project: R&D

>

Fall (2020, 2021, 2022)

o GAME 432 - Degree Project: Production

>

Spring (2021, 2022)

o GAME 434 - Professional Practices Game Industry

>

Spring 2020 — Co-Taught

06/2013 —08/2019: Participating Adjunct Professor in Game Art & Design at Woodbury University, Burbank, CA

Provide an in-depth learning experience and support for students across the artistic and creative range

of game arts.

Support program chair in developing or updating course material for new and existing game art courses.



e Summer Class - Intro to Game Design - 2014

o GAME 1700 - 7 weeks (Tuesday and Thursday morning and afternoon session)

o Using motion capture pipeline production techniques, high school students created storyboards;
directed a performer wearing the wireless motion capture suit; clean up mocap data, and hand
animated to develop a 30 — 45 second CGI animated short in Autodesk Motion Builder.

e MCD Creative Workshops - 3D Character Design - 2014, 2015, 2016, 2017, 2018

o 2.5 hours (Saturday morning session)

o Using 3D digital character sculpting techniques in zBrush, high school students were provided a
2D character concept as a background image and they would create a 3D skeleton; apply
digital clay to sculpt out shape and form; add an attention to details using micro textures and
custom brushes.

e Studio Courses — 3 Units (Semester System — 15 weeks)

o GAME 101 - Game Level Design 1

> Spring 2014
o GAME 105 -3D Game Fundamentals
> Fall (2014, 2015, 2016, 2017, 2018)
o  GAME 140 - Environmental Design Modeling
> Spring (2014, 2015, 2016, 2017, 2018, 2019)
>  Fall 2016
o  GAME 237 — Materials, Lighting, Rendering
> Fall (2014, 2015, 2016, 2017, 2018)
o  GAME 238 — Character Design & Modeling
> Spring (2015, 2016, 2018, 2019)
o GAME 302 - Degree Project
» Spring 2017
o GAME 307 - 3D Character Rigging
> Fall (2016, 2018)
o  GAME 308 - Cinematic Animation

» Spring 2019

o GAME 309 - 3D Game Animation
» Spring 2017
> Fall2015

o GAME 2707 — Game Level Design
>  Spring 2014

o GAME 431 - Independent Study
> Fall 2017

o GAME 432 - Independent Study
» Spring 2018

o  GAME 4990 - Independent Study
» Spring (2016, 2018)
o GAME 4991 — Independent Study

> Spring 2018
o GAME 499x — Independent Study
> Fall2017

08/2006 — 06/2019: Adjunct Professor in Media Arts at Mt Sierra College, Monrovia, CA

e Provide an in-depth learning experience and support for students across the artfistic and creative range
of media arfs (gaming and animation).
e Support program chair in developing or updating course material for new and existing media art
courses.
e Help support training to faculty on implementation of faculty learning system (D2L) for course resources
like rubrics and intelligent agents, assignments feedback, and grades.
e Link to College - Game Design & Gameplay - July 2011 & July 2015
o GAMOIT - 6 weeks (Saturday morning session)
o Using production pipeline techniques, high school students and people from the community
each week would be intfroduced fo different indusfry programs like 3D modelling for games;



interactive painting and sculpting in 3D; lights, camera, rendering; 3D bodies in motion, and
level design for games.
e Global Game Jam - January 2013, 2014, 2015, 2016, 2017, 2018

o 48 hours (Friday 5pm until Sunday 5pm)

o Using approved locations for this annual event, people of various skill levels and industry fields of
study will gather to participant and develop ideas, form small groups, create new and
innovative games, and ultimately present them to their peers and the global community world-
wide.

e Studio Courses — 4 Units (Quarters System — 11 weeks)
o GAMO0235 - Game Design & Gameplay
» Spring (2011, 2012, 2018)
» Summer 2012
» Fall 2010
» Winter (2011, 2012, 2017, 2019)
o GAMO0240 - Character Modeling
» Spring (2014, 2016, 2019)
» Summer (2014, 2017, 2018)
> Fall (2014, 2018)
> Winter (2015, 2018)
o GAMO0245 - Keyframe Animation
> Spring (2009, 2013, 2016)
» Summer 2013
> Fall (2009, 2010, 2013, 2015, 2016)
>  Winter 2013
o  GAMO0250 - Intfro to 3D
»  Spring 2011
> Fall (2011, 2012)
» Winter 2014
o  GAMO0252 - Material, Lighting & Rendering
»  Spring 2009
» Summer 2011
> Winter (2011, 2014)
o GAMO3T11 - Digital Sculpting
» Spring (2017, 2018)
» Winter 2019
o GAMO0315 - Character Setup and Rigging
> Spring (2010, 2011, 2012, 2016, 2018, 2019)
» Summer (2011, 2017)
> Fall (2008, 2009, 2017, 2018)
> Winter (2011, 2013, 2019)
o GAMO0321 - Alternative Techniques 1
> Spring (2007, 2008, 2009, 2012, 2013, 2016, 2018, 2019)
» Summer (2008, 2009, 2010, 2011, 2012, 2018)
» Fall (2009, 2013, 2018)
»  Winter (2009, 2010, 2012, 2013)
o  GAMO0325 - Level Design 1
> Spring (2011, 2012, 2013, 2014, 2015, 2016)
» Summer (2009, 2010, 2012, 2013, 2014, 2015, 2018)
> Fall (2010, 2011, 2012, 2013, 2014, 2015, 2016, 2018)
> Winter (2010, 2011, 2012, 2014, 2015, 2016)
o GAMO0330 - Alternative Techniques 2
> Spring (2008, 2009, 2010, 2013, 2014, 2015, 2016)
>  Summer (2008, 2009, 2012, 2013, 2014, 2015, 2016)
> Fall (2008, 2009, 2010, 2011, 2012, 2013, 2014, 2015, 2016, 2017)
> Winter (2007, 2009, 2012, 2013, 2014, 2015, 2016)
o GAMO0335 - Level Design 2
» Spring (2014, 2015, 2016)
» Summer (2013, 2014, 2015, 2017)



> Fall (2012, 2013, 2014, 2015, 2016)
> Winter (2013, 2014, 2015, 2016, 2018)
o GAMO0352 - Special Effects
>  Winter 2008
o  GAMO0432 - Advanced Digital Sculpting
» Summer 2017
> Fall2017
o  GAMO0460 - Scientific Visualization 1
» Summer (2009, 2010)
> Winter (2009, 2010)
o GAMO0462 - Scientific Visualization 2
>  Fall 2011
» Winter 2012
e Studio Courses — 2 Units
o  GAMO0400 - Senior Thesis 1 for Gaming
> Spring (2009, 2011, 2012, 2013, 2014, 2015, 2016, 2018)
» Summer (2009, 2010, 2012, 2014, 2015, 2016, 2017)
> Fall (2009, 2010, 2012, 2013, 2014, 2015, 2016, 2017)
» Winter (2010, 2011, 2012, 2013, 2014, 2015, 2016, 2018)
o  GAMO042]1 - Senior Thesis 2 for Gaming
Spring (2009, 2011, 2012, 2013, 2014, 2015, 2016, 2018)
Summer (2009, 2010, 2011, 2012, 2014, 2015, 2016, 2017)
Fall (2009, 2010, 2012, 2013, 2014, 2015, 2016, 2017)
Winter (2010, 2011, 20112, 2013, 2014, 2015, 2016, 2018)

YV V V VY

08/2006 — 03/2011: Full-time Professor in Game Art & Design at Westwood College, Upland, CA

e Provide an in-depth learning experience and support for students across the artistic and creative range
of game arts.
Support program chair in developing or updating course material for new and existing game art courses.
e Helped organize and create marketing material to promote the curriculum at the game developer
conference (GDC) in San Francisco.
e Quarterly Workshops - 2008, 2009, 2010
o 5 hours (Saturday morning session)
o Using in engine level building techniques within Unreal Tournament, potential students would
create a playable racing demo level from a library of provided 3D hard surface assets like
vehicles, buildings, trees, etc. The quarterly workshops were open to the community to create a
sense of awareness and recruitment.
e Studio Courses — 6.5 Units (5 Term System — 9 weeks)
o GA301 - Game Art Project
» Term 1 (2011)
» Term 2 (2007, 2008, 2009, 2010)
o GA340 - Texture Mapping for Games
> Term 1 (2007, 2008, 2009, 2010)
> Term 4 (2007, 2008)
> Term 5 (10/16/06 —12/16/06)
o GAS361 - Character Animation for Games
» Term 2 (2007, 2008, 2009, 2010)
» Term 4 (2009)
» Term 5 (2007, 2008)
o GA424 - Special Effects
» Term 3 (2007, 2008, 2009, 2010)
o GA445 - World Building
» Term 3 (2007, 2008, 2009, 2010)
» Term 5(2010)
o GA491 - Game Art Senior Project
» Term 3 (2007, 2008, 2009, 2010)



o GDI120 - Digital Image Editing

» Term 4 (2006, 2007, 2008, 2009, 2010)
o GD242 - 3D Modeling and Animation

» Term 5 (2006, 2007, 2008, 2009, 2010)
o GD260 - Fundamentals of 3D

> Term 4 (2006, 2007, 2008, 2009, 2010)
o GD330 - Game Design Process

» Term 5 (2006, 2007, 2008, 2009, 2010)
o GD360 - Intermediate 3D

» Term 1 (2007, 2008, 2009, 2010, 2011)

> Term 4 (2010)
o GD441 - 3D Modeling

» Term 2 (2007, 2008, 2009, 2010)

» Term 4 (2006)

» Term 5 (2009)
o GD464 — Animation for Visual Narrative

» Term 1 (2007, 2008, 2009, 2010, 2011)

04/2002 — 09/2005: Full-time Professor in Game Art & Design at Art Institute of California, Santa Monica, CA

Provide an in-depth learning experience and support for students across the artistic and creative range
of media arts (gaming and animation).

Support program chair in developing or updating course material for new and existing media art
courses.

Helped organize and establish internship network with local gaming companies like Treyarch, Naughty
Dog, and Pandemic.

Summer Workshop - July 2005

o GAD Studio - 1 week (5 days with a morning and afternoon session)

o Using game art and animation production pipeline techniques, each day the high school
students would be intfroduced to different industry programs like 3D hard surface modelling, 3D
character creation, 3D animation, lighting and rendering, and level design for games.

Studio Courses — 3 Units (Quarters System — 11 weeks)

o GADI00 - Survey of the Game Industry

»  Summer (2002, 2003, 2004, 2005)
> Fall 2002
o GAD270 - Game Design, Gameplay and Computer Simulation
> Spring 2002
»  Summer (2002, 2003, 2004)
> Fall 2003
» Winter 2003
o GAD325 - Lighting
» Summer 2005
> Fall (2002, 2003, 2004)
o GAD430 - Advanced Texture and Lighting
»  Spring (2003, 2004, 2005)
> Winter (2003, 2004)
o GAD450 - Interface Design for Games
»  Spring 2005
> Fall (2002, 2004)
> Winter (2003, 2004, 2005)
o GAD451 - Project Preparation
> Spring 2004
> Winter (2003, 2004, 2005)
o  GAD460 - Senior Project 1
» Spring (2002, 2003, 2004, 2005)
o  GAD470 - Senior Project 2
»  Summer (2002, 2003, 2004, 2005)



o MAI1134 - Principles of 3D Modeling
» Summer 2005
> Fall (2002, 2003, 2004)
o MAAZ220 - Introduction to 3D Modeling
» Spring (2002, 2003, 2004)
»  Summer 2004
> Winter 2005
o  MAA230 - Basic 3D Animation
» Spring (2003, 2005)
» Summer (2002, 2003)
> Fall (2003, 2004)
> Winter (2004, 2005)

SOFTWARE

3D: 3dsMax, Maya, Zbrush, xNormal, Headus UViayout, Topogun, Quixel Mixer, Substance Painter, 3D Coat,
Marmoset Toolbag 3, Akeytsu

Game Engine: Unreal Engine 4 & 5

Motion Capture: MVN Studio, Perception Neuron 3, Rokoko, Motion Builder
2D: Photoshop, lllustrator

Compositing/Editing: After Effects, Matchmover

INDUSTRY EXPERIENCE
PC GAMES:
Gigawatt Studios

Men In Black, Pinky and the Brain 1171996 — 04/1998

3D Digital Artist / Animator

DREAMCAST GAMES:

Co-Founder / Art Director / 3D
Digital Artist

Tremor Entertainment
05/1998 —05/2002

Sega Swirl, Railroad Tycoon I, Kiss
Psycho Circus

PLAYSTATION GAMES:

Tremor Entertainment

01/2000 — 05/2002 Co-Founder / Quality Assurance

Railroad Tycoon Il (port)

Digital Dimension

Snow Cross 2002 05/2002

Freelance 3D Digital Artist

XBOX 360 ON-LINE GAME:
Robo Blitz

Naked Sky Entertainment

02/2006 — 05/2006 Freelance 3D Digital Artist

MOTION CAPTURE SUPPORT:

The Black Eyed Peas Experience Zoic Studios Motion Capture Technician
05/2011
Lion Works Motion Capture Technician

Pok Ta Pok

Cal Trans Forensic Re-creation

The Walking Dead Slot Machine

Take A Seat

05/2012 -06/2012

Blast Radius Consulting
05/2011-02/2016

Stargate Studios
07/2013

Dark Road
12/2017 -01/2018

Visual FX Supervisor / 3D Digital
Artist / Motion Capture
Technician / 3D Forensic Artist

Motion Capture Technician

Motion Capture Technician



Forensic Re-creation Animation

ARDYs: A Radio Disney Music
Celebration, Snap Star Music Video,
Vampirina Interactive Web Blog,
Ghostbusters

MAIN ATTRACTION RIDE:
Mighty Ducks Pinball Slam

FEATURE:
Jenny Got A Boob Job (Short)

FABRICATION:
Chico’s, GAP, Federated, Avon,
Fashion Bug, Pac Sun, Koos MFG,

Victoria Secret, Club Monaco, Cato,

Belks, TC2

PUBLICATION:

Brainiac
EXPERIENCE:
Swarovski Crystal Experience

The Movie Nation Festivals

CONSULTANT:

REFERENCES AVAILABLE ON REQUEST

Bowley Inc
08/2016 — Present

Mobile Motion
03/2019 - 08/2021

Gigawatt Studios
01/1998 —03/1998

Harbinger Media
03/2002 - 05/2010

Shapely Shadow
10/2003 - 09/2010

Wildstorm Productions
12/1999 - 01/2000

Containment Field, Inc.
01/2009-11/2012

Mobile Motion
07/2018 - 08/2021

RBB Architecture, Inc.
02/2004 - 06/2006

Containment Field Studio
01/2016 - Present

SkillsUSA California
Interactive Video & Game
Design

09/2019 - Present

3D Digital Artist / Animator /
Motion Capture Consultant

Inertial Wireless Motion Capture
Technician and Clean-up Artist /
3D Character Rigger

3D Digital Artist / Animator

Co-Owner / Post Production
Supervisor

3D Digital Sculpt Artist

Freelance 3D Digital Artist

Co-Owner / Post Production
Supervisor /| Motion Capture
Specialist

Inertial Wireless Motion Capture
and Technical Support /| Mocap
Clean-up Artist / 3D Character
Rigger / Animation and Video
Game Production Training

On-Location Architectural Pre-Viz
Training and Technical Support

Los Angeles Mocap Director/

Post Production Supervisor

Competitive Events Coordinator /
Regional and State Judge



	08/2022 – present: Interim Chair in Game Art & Design at Woodbury University, Burbank, CA
	08/2019 – 08/2022: Assistant Professor III in Game Art & Design at Woodbury University, Burbank, CA
	06/2013 – 08/2019: Participating Adjunct Professor in Game Art & Design at Woodbury University, Burbank, CA
	08/2006 – 06/2019: Adjunct Professor in Media Arts at Mt Sierra College, Monrovia, CA
	08/2006 – 03/2011: Full-time Professor in Game Art & Design at Westwood College, Upland, CA
	04/2002 – 09/2005: Full-time Professor in Game Art & Design at Art Institute of California, Santa Monica, CA
	3D: 3dsMax, Maya, Zbrush, xNormal, Headus UVlayout, Topogun, Quixel Mixer, Substance Painter, 3D Coat, Marmoset Toolbag 3, Akeytsu
	Game Engine: Unreal Engine 4 & 5
	Motion Capture: MVN Studio, Perception Neuron 3, Rokoko, Motion Builder
	2D: Photoshop, Illustrator
	Compositing/Editing: After Effects, Matchmover
	INDUSTRY EXPERIENCE

